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4. Projects 
This section provides an overview how projects are created, opened, and edited in NavView.  

4.1 Overview 
NavView uses the concept of Projects and Stations to define the overall configuration and 
setup of the software for a construction operation or project and the NavView clients in use 
for the project. These concepts and how they are applied are detailed in this section. 

If Roles and Privileges are enabled, the following are what is allowed for each role: 

Roles Privileges 
Not Logged In Cannot Open, create New, Import or Save As a project 

User Cannot Open, create New, Import or Save As a project 
Online/Supervisor Can Open, create New and Save As a project; Cannot 

Import a project 
Admin (Administrator) Can Open, create New, Import and Save As a project 

4.1.1 Project 

In NavView terms, a project is a specific set of configurations and supporting files associated 
with a construction project or specific phase of a project. These are divided into three basic 
levels. The top level involves the configuration information that is required for and common 
to the entire project. This includes geodesy and project details. The next level involves the 
supporting files and data that are Shared for the project, for example, background drawings, 
digital terrain model (DTM) files, 2-dimensional and 3-dimensional visual object files, etc. The 
final level involves configurations and data specific to each of the NavView clients, also 
referred to as Stations, deployed for the project operation, for example device, calculation 
and vehicle configurations. These are considered to be Local. 

Projects can be created, edited and opened as required. This capability can be used by the 
operator to easily switch between projects or configurations specific to different operations 
within a single project. 

4.1.2 Station 

A station is a NavView client involved in a project configured to meet a specific requirement. 
Examples of a station are the online survey NavView system, an ROV van NavView system 
providing vehicle tracking and monitoring for ROV operators, a DPS NavView system providing 
vehicle tracking and monitoring as well as limited control of operations for the DPOs, and a 
remote NavView system operating as the online system on a support vessel. A station uses 
the project configuration as the base for its configuration but is then refined with station 
configuration options such as devices interfaced with, vehicles added and their configuration 
and presentation options, etc. 

Note: A Station is a specific instance of NavView client and is not to be confused with a 
vessel or vehicle configuration. A single vessel may have multiple stations deployed 
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throughout, each meeting a specific requirement for the manipulation and presentation 
of data, any one of which may define and configure one or more vehicles. A single 
vessel may also have only a single station that includes the definition and configuration 
for that vessel only. 

The configuration for a NavView station is Local to that station. 

Note: It is important to be aware that NavView utilizes and assigns Globally Unique Identifiers 
or GUIDs to all objects involved with a station’s configuration making each station itself 
unique. As a result, a station is not to be duplicated within a project, i.e., do not 
manually copy an existing Local station folder in a project and use for another station.  

4.2 Project Folder 
NavView utilizes a specific project folder structure and while the user is not constrained to 
follow this structure for all aspects of the configuration, it is recommended. The project 
folder structure follows the concept of Shared and Local. It is 
designed to facilitate local and remote operations. Figure 4-1 
shows the project folder hierarchy. Each NavView client has a copy 
of the Project folder. 

Project folders contain two primary subfolders: Local and Shared. 
Within the Local folder are subfolders containing the configuration 
for specific stations based on that station’s name. These include 
device interface configuration, calculations configuration, vehicles 
configuration, workspace window layout, etc. These folders and 
files are placed here by NavView and must be located here. 

Note: It is not necessary for any one station to have the Local 
station folders for all stations on the network, only that for 
itself. 

Those project files that are of a more general nature and may wish 
to be available to other NavView systems via the data server are in 
the Shared folder. These include files such as vehicle shapes, 
waypoints, pipelines, rig moves, etc. NavView automatically creates 
the Shared folders shown in Figure 4-1. The user must populate 
them accordingly. 

The critical project configurations that are used by all NavView 
stations are in the project folder itself, specifically addressing 
Geodesy, Preferences and Project. 

While it is possible to utilize files in NavView that are not located 
within the respective project folder, it is strongly recommended 
that this be avoided. Keeping the project self-contained promotes file and project 
management, simplifies archiving and facilitates technical support because the project can 
easily be replicated by loading the project. 

Figure 4-1 Projects - 
Folder Structure 
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Note: File paths are saved to the respective configuration files relative to the project folder. 
Therefore, selecting files that are located outside of the project folder can result in 
paths that are easily broken. 

The following provides a summary of the folders and their contents. 

4.2.1 Local > Station Folder 

 Config 
• Configuration files for the respective station, including vehicles, IO devices, 

network service settings, etc. 
 Data 

• ADCP 
• Logs 

– NavView writes a log file capturing general information of the software’s 
operation, including such things as the changes in states of calculations, 
software issues (exceptions) if they occur, etc. 

– Each file captures one day based on UTC with the file name giving the 
date covered, yyyy-mm-dd.log 

• RawData 
– When using the option to log raw device data, the captured data is written 

to this folder 
– A folder is created for each device being logged that contains the 

captured data 

Note: When creating a ZenDesk ticket reporting an issue, it is recommended to include the 
respective log file that includes the period the issue was experienced. 

 State 
• Files used to store the states of various NavView operations and assets, e.g., 

AnchorState.xml when using the Anchor Management module 
 Working 

• Local copies of waypoints, survey lines and pipelines data 

4.2.2 Shared > Data Folder 

 Database 
• This is the default folder that database files are written when using SQL 

localDB 
• Using this default simplifies the archiving of projects since all the data is 

contained in the project folder 

4.2.3 Shared > SyncFolder 

 Files that are to be automatically distributed to NavView clients connected to the 
network services can be located in this folder 
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 NavView monitors this folder and when a file is added it distributes it to the other 
NavView 

 Files that are distributed are placed in this folder on the receiving NavView clients 

Note: Files used for displaying background visuals in the Map views such as *.dwg, *.dxf, 
*.geotiff, GIS files, do not need to be located in the SyncFolder in order to be 
distributed. They are distributed when loaded by any of the NavView clients connected 
to the network services. 

Note: DTM files used to generate the seafloor for display in the 3D views do not need to be 
located in the SyncFolder in order to be distributed. The DTM is distributed when it is 
loaded from Database Services by any NavView client connected to the network 
services when using SQL Server (not SQL localDB). 

4.2.4 Shared > Visuals Folder 

 2D Background 
• Recommended location for all files to be used for displaying background 

information in Map views, e.g., *.dwg, *.geoTIFF 
 3D Seafloor 

• Recommended location for DTM files to be loaded in NavView to display the 
seafloor in 3D views 

 GIS 
• Recommended location for ESRI SHP files to be loaded for displaying 

background information in Map views 
 Objects 

• 2D Outlines 
– Original recommended location for files to be used for vehicle outlines, 2D 

visuals for waypoints, etc. 

Note: Pre v3.6, vehicle outlines were distributed as geometries with the vehicle configuration 
to other NavView clients connected to the network services. From v3.6 onwards, only 
the file name and path is distributed with the vehicle configuration, therefore in order 
for other NavView clients to display vehicle outlines they must have a copy of the 
respective file in the same path. This can be achieved automatically by moving/copying 
this folder to the SyncFolder. 

• 3D Models 
– Original recommended location for files to be used for vehicle shapes, 3D 

visuals for waypoints, etc. 
– As with the 2D Outlines folder, the user should consider moving/copying 

this folder to the SyncFolder. 

4.2.5 Shared > Working Folder 

 Contains local copies of data pertaining to specific NavVIew operations and 
modules, e.g., AnchorConfig.xml when using the Anchor Management module. 
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4.3 Create a New Project 
Projects are created using the New Project wizard. This steps the user through creating the 
project and configuring the critical component (Geodesy) after which the user can work 
through the remaining configuration process by directly accessing the respective 
configuration dialogs and windows. These will generally be Devices, Calculations and Vehicles 
in this order to setup how incoming data will be used. This will be followed by opening and 
configuring views to monitor operation and present the data in a way to accomplish the goals 
of the project, e.g., 2D views, 3D views, route guidance, etc. 

Note: If Roles are enabled, only a user with Supervisor or Administrator privileges can create 
a new project. 

1. Launch the New Project wizard by expanding the File menu and clicking on New; 
or 

2. From the No Project Loaded Dialog, click on New. 
3. Enter the name of the new project. This should be descriptive but not long. Note 

that the wizard will not let you use the name of an existing project. Click Next. 

 
Figure 4-2 Project Wizard - Project Name Page 

4. Configure the Horizontal CRS (see Geodesy section for details) 

Note: When creating a new project on a NavView remote that will connect to an existing 
project on the MongoDB and Redis services, i.e., the Horizontal CRS(s) and 
transformation(s) have already been setup and configured on the online licensed 
NavView, do not make any changes on this page, just click Next. This remote will get 
the configuration from the server when it is connected to the network services. 
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Figure 4-3 Project Wizard - Horizontal CRS Page 

a. If the default working Horizontal CRS is the desired CRS and no other CRS are to be 
added click Next, otherwise click Add to select a CRS from the EPSG database or 
User to add a user defined CRS. 
i. Upon adding a CRS, you will be asked if you wish to  

A. Set the newly added CRS to working, click Yes or No accordingly 
B. Configure datum transforms for the new CRS, click Yes or No accordingly 
C. Repeat step (a.) as required for the Horizontal CRS required for the project 

b. Click Next 
5. Configure the Vertical CRS (see Geodesy section for details) and click Next. 

Note: When creating a new project on a NavView remote that will connect to an existing 
project on the MongoDB and Redis services, i.e., the Vertical CRS has already been 
configured on the online licensed NavView, do not make any changes on this page, just 
click Next. This remote will get the configuration from the server when it is connected 
to the network services. 

 
Figure 4-4 Project Wizard - Vertical CRS Page 

6. Edit the Project Configuration (see Configuration for details) and click Next. 



  
 

4D Nav, LLC 
NavView User Guide – 04 Projects  
Document: 4DN_NVUG_S04_01B  
Release: 01  Revision: B    Page 4-7 
 

 
Figure 4-5 Project Wizard - Project Configuration Page 

7. Configure the Preferences for the units and format used to display data in NavView (see 
Preferences for details) and click Next. 

 
Figure 4-6 Project Wizard - Preferences Page 

8. Specify the station to implement during the new project creation. 
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Figure 4-7 Project Wizard - Station Name Page 

a. If a new station is to be created 
i. Select Create new station 
ii. Enter the name to use 
iii. Specify if new station is active or not by checking or unchecking the Is Station 

Active box. If a station is set Active any outputs it is configured for, e.g., 
configurable output for a video overlay system will be enabled for output. If a 
station is not set as Active outputs are not enabled  

b. If an existing station is to be used 
i. Select Import existing station 
ii. From the Project drop-down list, select the existing NavView project that the 

station to import is part of 
iii. From the Station drop-down list, select the existing NavView station from those 

present in the selected project to import 
iv. Specify if station is to be active or not by checking or unchecking the Is Active 

Station box in the Project Configuration window 

Note: The option to import an existing station into a new project facilitates the reuse of one 
that has already been configured and will be used in the new project in the same or 
very similar configuration. For example, on a permanent NavView installation on a 
construction vessel the configuration for the online survey station will generally be 
unchanged for the most part from one project to the next. This station will usually 
include the configuration for the devices interfaced with, vehicle configurations, etc. 
The option to import it from an existing project into the new project streamlines the 
setup process from project to project without introducing the issue of GUID conflicts 
created if the folder is simply copied in Windows Explorer and loaded. 

Note: Geodetics, Waypoints, Survey Lines, Pipelines, Backgrounds, Databases not imported. 

9. If modules and features are present that require specific project configuration, e.g., 
Anchor Module, the respective wizard pages will display after the Station page. Complete 
these and continue with the wizard. 

10. Click Finish to complete the creation of the new project and base configuration. NavView 
will create the project folder and specific base sub-folders shown in Figure 4-8 under 
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Public Documents\4D Nav\NavView\ and then be ready to proceed with the rest of the 
configuration. 

 
Figure 4-8 Project Folders Created 

11. (Optional) Upon completing the new project wizard and prior to proceeding with the 
configuration of the project, supporting files should be copied into the respective folders, 
e.g., dwg files to be used as backgrounds for 2D views into Shared\Visuals\2D 
background, dwg/veh/shp files to be used for vehicle outlines into 
Shared\Visuals\Objects\2D Outlines, and 3DS model files into Shared\Visuals\Objects\3D 
Models. This are then available during the configuration process. 

12. Proceed to access the individual configuration dialogs and windows to continue the 
configuration. 

4.4 Open an Existing Project 
The user has the option to open an existing project and station or create a new station in an 
existing project. This facilitates opening a previously setup station and project (e.g., opening a 
station and project in the field after setting it up in the office) and setting up client NavView 
systems in a multi-NavView spread (e.g., online secondary, DP and ROV stations on a 
construction vessel). 

Note: If Roles are enabled, only a user with Online/Supervisor or Administrator privileges can 
create a new station. 

1. Launch Open Project wizard by expanding the File menu and clicking on Open; or 
2. From the No Project Loaded Dialog, click Open. 
3. Select the project from the drop-down list and click Next. 
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Figure 4-9 Open Project Wizard - Select Project Page 

4. Specify the station to use for the project. 

 
Figure 4-10 Open Project Wizard – Select Station Page 

a. If an existing station in the project is to be used 
i. Select Existing Station 
ii. Select the station from drop-down list of those present in the project being 

opened 
iii. Specify if the existing station’s Active Station setting is to be overridden by 

checking or unchecking the Override Active Station setting box 
iv. If overriding the existing station’s Active Station setting, specify if station is to be 

active or not by checking or unchecking the Is Active Station box 
b. If creating a new station in the project 

i. Select New Station 
ii. Enter the new station name 
iii. Specify if new station is Active or not by checking or unchecking the Is Station 

Active box  
c. Click Finish 

4.5 Launch a Project on Start Up 
When NavView is launched it loads the last project and station it was configured for when it 
was exited. This information is contained in the file C:\Program Data\4D 
Nav\NavView\Settings.xml. If this file has been deleted or if either the specified project or 
station folder cannot be located, the operator is prompted to open an existing project or 
create a new one via the prompt shown is Figure 4-11. 
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Figure 4-11 No Project Loaded Dialog 

New: Launches the new project wizard 

Open: Launches the open project wizard 

X: Closes the dialog but does not close the application. A project may still be 
opened or created from the main menu 

4.6 Launch a Project From the Command Line 
NavView can be launched into a specific project and station from the command line or from a 
*.bat file using the following format 

[Path]\NavView.exe “ProjectName” /s:”StationName” 

For example, using the desktop link to NavView to open the NavView project Project and the 
station Station: 

"C:\Users\Public\Desktop\NavView.lnk" “C:\Users\Public\Documents\4D Nav\NavView\Project” /s:”Station” 

4.7 Import a Station 
NavView supports the option to import a previously created station simplifying their reuse for 
multiple projects. This can be useful when creating a project in the office for deployment in 
the field that involves multiple stations that do not change between projects. For example, an 
Anchor project can often re-use stations for the rig and each anchor tug. 

Note: If Roles are enabled, only a user with Administrator privileges can import a station. 

Note: Geodetics, Waypoints, Survey Lines, Pipelines, Backgrounds, Databases not Imported. 

1. Access the Import Station by expanding the File menu and clicking on Import.  
2. Project: Select the existing NavView project that contains the station to be 

imported. 

 
                                                    Figure 4-12 Import Station Dialog 
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3. Station: Select the station to import from those present in the selected project. 
a. Click Import. 

4. If the station already exists in the project, you will be asked if you want to overwrite the 
station, answer Yes to overwrite the station or No to abort the import process and return 
to the Import Station dialog 

5. If the import is successful, you will be prompted to open the new (imported) project 
station, answer Yes to switch to the new station or No to remain with the current station 
and return to the Import Station dialog. 

6. Click Cancel or X to close the dialog. 

4.8 Edit a Project 
Editing the project in this case refers to accessing and editing the configuration that was 
setup as part of the new project wizard. These are as follows. 

4.8.1 Geodesy 

This is accessed by clicking the Horizontal CRS and/or Vertical CRS buttons in the Project 
section of the Setup ribbon, or alternatively clicking on the same in the Explorer window. See 
the Geodesy section for details. 

Note: If Roles are enabled, only users with Supervisor or Administrator privileges can edit the 
Geodesy. Others can view the settings but not change them. 

4.8.2 Project Configuration 

This is accessed by clicking the Configuration button in the Project section of the Setup 
ribbon, or alternatively clicking on the same in the Explorer window. This provides access to 
the Project Configuration page. This page has the Config Preferences and Environmental 
Parameters Tabs. These configurations are discussed in detail here. 

Note: All users can edit the project configurations. 

Any changes to any tabbed or non-tabbed options will activate the Apply button. Clicking the 
Apply button applies all the changes regardless of the tab displayed at the time and leave the 
window open. 

Clicking the OK button applies all the changes regardless of the tab displayed at the time and 
closes the window. 

4.8.3 Active Station 

Above all the tabs, the checkbox Active Station provides the option to control if the station is 
to be active (outputs are enabled) or not active (outputs are disabled). 

4.8.4 Configuration Tab 

The Config tab enables the user to enter general project information to assist project 
management and tracking. 
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Figure 4-13 Project Configuration - Config Tab 

4.8.5 Preferences 

The Preferences configuration enables the user to configure the default units and format for 
the presentation and entry of data in windows, dialogs and reports. In the case that 
window/report specific control of the units and/or formats is supported, the default are 
those set in Preferences. 

 
Figure 4-14 Project Configuration - Preferences Tab 
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4.8.6 Units of Measure 

Select the units to be used when displaying data. These settings will also dictate the units 
assumed when data is loaded or entered without a unit designation. If units are included in 
any data loading and entry process, the data is loaded and accepted in those units. 

4.8.7 Display Format 

Select the format to be used to display the respective data. In general, the following apply to 
these settings: 

 Options are presented in a drop-down list 
 The number of decimal places to display is indicated by the number of the 

respective format type after the decimal place 
• For distances, depths, speed and density the number 0’s 
• For angles the number of d’s if the format is to be degrees and decimal 

degrees, m’s if the format is to be degrees minutes and decimal of minutes, 
etc. 

 For time the number of f’s following the seconds (ss) for decimal seconds 
 The use of a delimiter between thousands and hundreds is indicated by creating 

the digit spaces to the left of the 1s with ‘#’ 
 The presence of a unit term is indicated by the presence of a ‘u’ 
 The location of the hemisphere term is indicated by the location of the ‘I’ for 

geographic coordinates 

4.8.8 Other 

Options applicable to the general operation of NavView are presented her. 

 Text View Stale Age 
• Enter the age at which any data displayed in a Text view is presented with 

strike through indicating it is old 

4.9 Project – Save As 
Save As is used to save the current NavView project to a New project folder. 

Note: Waypoints, Survey Lines, Pipelines, Backgrounds, Databases not copied over to new 
project folder. 
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Note: If Roles are enabled, only a user with Online/Supervisor or Administrator privileges can 
access Save As. 

1. In the directory containing stored projects, i.e. 
C:\Users\Public\Documents\4D Nav\NavView add a new folder with the new 
project name. 

2. Select Save As in the file menu.                                                                                                                                                                                     
3. Navigate to the new folder and select. 
4. Select Open in the NavView file menu and select the new project to load 

into NavView. 

4.10 Primary and Secondary Online NavView Systems 
Often real-time redundancy of the online NavView and associated server is required to ensure 
operations can continue in the case of a system failure. These configurations involve a 
Primary Online NavView and a Secondary Online NavView (hot spare). 

There are different approaches to configure this type of setup. The following is one option. As 
familiarity with NavView increases, users are encouraged to develop their own configurations 
suited to their requirements. 

Note: If NavView remotes are in use, install the MongoDB and Redis network services on both 
the Primary and Secondary servers (may be the respective online computers). If one or 
more of the remotes requires access to the data logged by the servers, install SQL 
Express on both as well. In both cases, the following steps assume the installation is 
as per the instructions given in Section 1. Introduction of the User Guide with the 
services and SQL Express hosted by the online computers. 

4.10.1 Initial Setup 

1. Install the required software on the Primary and Secondary computers and if applicable 
servers 

2. Run NavView on the Primary computer and configure the project, including but not limited 
to devices, calculations, vehicles, background drawings, views, etc., and if applicable 
network services and database services 

Note: Set the Station to active. 

Note: When configuring database services, if SQL Express is to be used and is hosted on the 
same NavView computer, rather than configuring the Server name using the local 
computer’s name, use the default local IP address, e.g., 127.0.0.1\SQLEXPRESS, or 
localhost\SQLEXPRESS. 
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Figure 4-15 Primary NavView SQL Express Database Services Configuration 

Note: When configuring network services and the services are hosted on the online 
computer, use the default localhost settings. 

 

Figure 4-16 Primary NavView Network Services Configuration 

3. Copy the project from the Primary computer to the Secondary 
4. Launch NavView on the Secondary computer and open the just copied project and station 

a. On the Select Station page, check the Override Active Station setting and ensure the 
Is Active Station box is unchecked then click Finish 

 

Figure 4-17 Secondary NavView Is Active Station Override 

5. Check the Secondary MongoDB and Redis services, and if applicable, SQL Express settings 
in NavView 
a. If these are hosted on the Secondary online computer, and the settings used on the 

Primary online computer are as suggested above (using 127.0.0.1 or localhost), no 
further configuration is required, just confirm they have connected correctly to the 
local instances 

b. Otherwise, edit these to point them to the Secondary computer/server where they are 
hosted 

6. Review all output devices and set the Override is Active setting as required, i.e., any 
device that is to output regardless of whether it is a Primary or a Secondary NavView. 
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4.10.2 Maintaining Primary/Secondary Synchronization 

The objective is to have the base project on the Primary completed before copying it to the 
Secondary. In this scenario it is the user who then must maintain synchronization by ensuring 
that when a change is made to the Primary, e.g., a new route is imported and the Guidance 
updated to reflect this, the same changes are made to the Secondary. 

More advanced methods involving MongoDB replication technology are also applicable. For 
details on this methodology contact 4D Nav. 

4.10.3 Switching from Primary to Secondary 

In the case of a failure of the Primary: 

1. Set the Secondary to active via Setup > Configuration 

 

Figure 4-18 Active Secondary - Is Active Station Setting 

2. Set all NavView remotes’ Network Services (and if applicable Database services) to point 
at the Secondary NavView, i.e., change the IP address and/or PC name to the Secondary 
computer. 
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